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The Workspace
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the R workspace

working directory

The R workspace consists of any user defined object (vectors, matrices,
data frames, etc).

The following are some standard commands useful for managing the
workspace:

# print the current working directory
> getwd()

# list the objects in the workspace
> 1s()

# change the working directory
> setwd(new.dir)
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the R workspace

options

We can use the command options to view and
set options for the R session.

**

list of available options
help(options)

\

# view current options settings
options()

v

# set number of digits to print on output
> options(digits=3)

it

R Programming II: Data Manipulation and Functions UCLA SCC

Denise Ferrari denise@stat.ucla.edu




the R workspace

session history

# display last 25 commands
> history()

# display all previous commands
> history(max.show=Inf)

# save your command history to a file
> savehistory(file="myfile") # default is ".Rhistory"

# recall your command history
> loadhistory(file="myfile") # default is ".Rhistory"
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the R

workspace

saving and loading workspaces

VvV # V #

H*

save the workspace to the file ".RData" (default)
save.image()

which is the same as

save(list=1s(all=TRUE), file=".RData")

save a specific object to a file
save (object, file="myfile.RData")

load a saved workspace into the current session
load("myfile.RData")

quit R
q0)

to avoid having R asking you whether it should save your data
q(save="no") “LM
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packages

Packages consist in a set of pre-programmed functions, sometimes
developed for performing specific tasks.

There are two types of packages:
@ Those that come with the base installation of R.

@ Those that are available for download and need to be installed
manually.
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packages included in the base installation

To check which packages are available in your R installation:
@ choose Packages & Data > Package Manager

Even if a package came with the base installation, you may need to load
it in order to be able to use its functions.

load the package "splines"
library(splines)

or

require(splines)

VvV # VvV #

+*

to get help with the package
> help(splines)

N
Now, you can start using the functions included in that package. éwg‘ lléj
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extra packages

If a package is not included in the base installation, you need to install it.
You can either download it from the R website, or you can do it within
the R environment:

To obtain and install the package gstat (or any other available package)
from within R:

@ choose Packages & Data > Package Installer

@ type gstat in the package search field and hit ‘Get List’

@ choose the desired package and click ‘Install Selected'.

Note: The process of installing a package needs to be done only once.

it

UCLA sCC

Denise Ferrari denise@stat.ucla.edu
R Programming II: Data Manipulation and Functions




Part Il

Data in R
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Mode and Class

mode and class

Every R object has a number of attributes.
Some of the most important are:

mode: Mutually exclusive classification of objects according to
their basic structure.

@ numeric, complex, character, logical

class: Property assigned to an object that determines how
generic functions operate with it. If no specific class is
assigned to object, by default it is the same as the mode.

it
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Mode and Class

mode and class

Example

Let’s check the mode and the class of simple R objects:

First, create a simple vector in R and

Now, let’s associate the attribute
check its mode and class:

“dimension” to the vector:

> x <- 1:4
> mode (x)
[1] "numeric"
> class(x)
[1] "integer"

> dim(x) <- c(2,2)
> mode (x)

[1] "numeric"

> class(x)

[1] "matrix"
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Mode and Class Data Classes

®00000000

Vectors

vectors

@ The vector is the basic data object in R.
@ Even scalars are defined as vectors of length 1.

@ All elements in a vector must be of the same mode.
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Mode and Class

Data Classes

[e] Jo]e]e]e]ele]e)
Vectors

creating vectors

elements in sequence

# using the operator ":"
> x <- 1:4

> x

[11 1234

> mode (x)

[1] "numeric"

# using the function seq()
> y <- seq(from=6, to=9, by=0.5)

>y
[1] 6.0 6.5 7.0 7.5 8.0 8.5 9.0
> mode (x)

[1] "numeric"
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Mode and Class

Data Classes

[e]e] le]e]e]ele]e)
Vectors

creating vectors

other vectors

# Using the function repeat "rep()"
> z <- rep(TRUE, 2)

>z

[1] TRUE TRUE

> mode (z)

[1] "logical"

# Using the function concatenate "c()"
> w <~ c(5, 7, "dog", 9)

> w
[1] "5" II7" Ildog" I|9II
> mode (w)

[1] "character"
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Data Classes

[e]e]e] le]e]ele]e)

Vectors

creating vectors

other vectors

Now, try concatenating the vectors x, y, z.
What is the mode of this new vector?

What if you concatenate the vectors x, y, z, w?

it
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Mode and Class Data Classes

[e]e]o]e] lelele]e)
Vectors

name assignment

We can assign names to the elements of vectors.
These names are useful to identify elements when the object is displayed
and also to access elements of the vector through subscripts.
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Mode and Class Data Classes
[e]e]e]e]e] lele]e)
Vectors

name assignment

Names can be assigned when the vector is created:

> x <- c(one=1, two=2, three=3)

> x
one two three
1 2 3

it
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Mode and Class Data Classes

[e]e]e]e]e]e] le]e)
Vectors

name assignment

Or can be added later:

> x <= 1:3
> x
[11] 1 2 3
> names(x) <- c("one", "two", "three")
> x
one two three
1 2 3

it
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Mode and Class

Data Classes
0000000e
Vectors

name assignment

We can also use names as indexes to modify certain elements of the
names:

> names(x) [c(1,3)] <- c("a", "c")

> x
a two c
1 2 3

it
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Mode and Class Data Classes

00000000e
Vectors

recycling

If two vectors in a certain operation are not of the same length,
R recycles the values of the shorter vector to make the lengths
compatible.

it
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Mode and Class Data Classes
000000000
Vectors

recycling

Recycling a scalar:

> a <-1:10
>a+ 1
[1] 2 3 4 5 6 7 8 9 10 11

it
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Mode and Class Data Classes

000000000
Vectors

recycling

Recycling a shorter vector:

> a <- 1:10
> a+ c(1,2,3)

[11 2 4 6 5 7 9 810 12 11
Warning message:

In a + c(1, 2, 3)
longer object length is not a multiple of shorter object length

it
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Mode and Class Data Classes

000000000
Vectors

recycling

Recycling a shorter vector:

> a <- 1:10
>a+ c(1,2)

[11 2 4 4 6 6 8 8 10 10 12

There is no warning when the length of longer vector is a multiple of the

length of the shorter vector!
ém’.lﬂ' wﬂ
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Mode and Class

Arrays and Matrices

arrays and matrices

@ An array is a multidimensional extension of a vector.
o Like vectors, all elements of an array must be of the same mode.
@ Arrays have an attribute called dim (dimension).

@ The most common array used in R is the matrix, which corresponds
to a 2-dimensional array.

it
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Mode and Class

Arrays and Matrices

creating matrices

Matrices are stored internally as vectors, with each column “stacked” on

top of each other.

> mat <- matrix(1:6, nrow=2, ncol=3

dimnames=1ist (NULL, c("A","B","C")))

> mat
Names can always be
ABC assigned later to the
[1,] 135 columns and rows of
[2,] 246 the matrix using the
commands
> dim (mat) row.names () and
[1] 2 3 col.names ()

If we want the matrix
to be filled in by rows,
we need to use the
option

byrow = TRUE
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Mode and Class

Lists

lists

Lists are generic vectors that allow elements of different modes.

> mylist <- list(1:3, "dog", TRUE)
> mylist

[[1]1]

[11 123

[[2]1]
[1] "dOg"

[[3]]
[1] TRUE

> sapply(mylist, mode)
[1] "numeric"  '"character" "logical"

Now, try to give names to the elements of a list.

oy
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Mode and Class

Data Frame

data frames

Data frames are useful to store data in matrix-like form,
while allowing for different modes.

Note: A data frame is a special list whose elements have equal lengths:
mode: list

class: data.frame

it

R Programming II: Data Manipulation and Functions UCLA SCC

Denise Ferrari denise@stat.ucla.edu




Mode and Class

Data Frame

creating data frames

> dat <- data.frame( book = c("B1","B2","B3"),
author = c("A1", "A2","A3"),
year = c(1950, 2005, 1999),
used = c(TRUE, FALSE, TRUE) )

> dat

book author year used
1 Bl A1 1950 TRUE
2 B2 A2 2005 FALSE
3 B3 A3 1999 TRUE

> sapply(dat, mode)
book author year used
"numeric" "numeric" "numeric" "logical" Now, try to check the mode and
the class of the data frame.

> sapply(dat, class)

book author year used IL
"factor" "factor" "numeric" "logical" l M
é- '] 'w £
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Data Classes

Converting Objects

converting objects

We can convert R objects to another mode or class in order to change
the way the object in R behaves.
The functions to perform conversion begin with the prefix

‘ "
as.

Examples:
as.numeric()
as.character()
as.matrix()

as.data.frame()

it
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Mode and Class

Converting Objects

converting characters to numbers

> x <- sample(rep(c(0,1), c(3,5)))
> x
[1110101011

# The function table returns the counts
# of 0’s and 1’s in x

> tt <- table(x)
> names (tt)

[1] nwon nqe

# what happens if we try to do this?
> sum(names(tt) * tt)

# now, try the following:
> sum(as.numeric(names(tt)) * tt)

R Programming II: Data Manipulation and Functions UCLA SCC
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Mode and Class

Converting Objects

converting to list

list versus as.list

> x <- 1:3

> list(x)
[[1]1]
[11 1 2 3

> as.list(x)
[[11]
[1] 1

[[211
[11 2

(311
[1]1 3

list creates a list of length one
containing the elements of the vector x.

as.list converts the vector x into a list
of the same length as the vector.
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Mode and Class

Converting Objects

conversion of logical variables

The conversion of logical variables in a numeric context is performed
automatically:

> x <- -2:5
> x
[1] -2 -1 0 1 2 3 4 5

>x >0
[1] FALSE FALSE FALSE TRUE TRUE TRUE TRUE TRUE

> sum(x > 0)
[1] 5

Now, use the conversion of logical values to count the number of elements that are

not equal in the matrices:
a <- matrix(1:9, ncol=3)

b <- matrix(1:9, ncol=3, byrow=TRUE) ,
cantisl)
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Part IV

Reading Data
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Reading Vectors and Matrices

reading vectors and matrices

data of the same mode

When all the data is of the same mode, the scan() function can be used
to store them in a vector or matrix.

By default, scan() interprets the data as numeric.
This can be changed by the argument ‘what='".

it
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Reading Vectors and Matrices

the scan() function

reading vectors from the console

When reading vectors from the console, R will show the index of the next
item to be entered. Once it is done, R shows the number of elements

read.

# To read numeric elements # To read characters, set what=""

> numbers <- scan() > pets <- scan(what="")

1: 1234 1: cat dog bird

5: 5 4 4: turtle fish

7: 6:

Read 6 items Read 5 items

> numbers > pets

[1] 123454 [1] "cat" "dog" "bird" "turtle" "fish"

ikt
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Reading Vectors and Matrices

the scan() function

reading lists from the console

The ‘what=" argument is a list containing examples of the expected data
types. Numeric values are specified by 0.

> pets <- scan(what=list(pet="", number=0, male=0))
1: dog 1 1

2: cat 31

3: fish 10 5

4:

Read 3 records

> pets

$pet

[1] "dog" "cat" "fish"
$number

[11] 1 3 10

$male

(11115 ém".w
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Reading Vectors and Matrices

the scan() function

reading matrices from the console

> mat <- matrix(scan(), ncol = 3, byrow = TRUE)

1: 123
4: 2 4 6
7: 369
10:
Read 9 items
> mat

[,11 [,2]1 [,3]
[1,] 1 2 3
[2,1] 2 4 6
[3,] 3 6 9

&

Note: We use byrow = TRUE so that the matrix is filled as we type it. ul ! l
! alIA
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Reading Vectors and Matrices

the scan() function

reading from a file

> filename <- "http://www.stat.ucla.edu/~denise/SCC/housing.data"
> raw <- scan (file=filename,

what=c(£1=0, NULL, £3=0, £4=0, rep(1list(NULL),10)))
Read 545 records

# store the data in a matrix
> housing <- cbind(raw$fl, raw$f3, raw$f4)
> head(housing)

[,1] [,2] [,3]

[1,] 0.00632 18.00000 0.53800
[2,] 24.00000 0.02731 0.00000
[3,] 9.14000 21.60000 7.07000
[4,] 392.83000 4.03000 0.00000
[6,] 18.70000 394.63000 0.06905

[6,]1 222.00000 18.70000 36.20000
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Reading Data Frames

reading data frames

data with different modes

To read data into R in the form of a data frame,
we use the function read.table().

Note: For data of a single mode, it is more efficient to use scan().

it
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Reading Data Frames

the read.table() function

> filename <- "http://www.stat.ucla.edu/data/pnc/anneal.dat"
anneal <- read.table (file=filename, header=TRUE, sep="")
> head(anneal)

TRR LAMBDA PIXELS

v

10.7 5 660
2 0.7 5 489
3 0.7 10 446
4 0.7 10 308
5 0.9 5 1013
6 0.9 5 1153

it
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Part V

Generating Data
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generating data

Sometimes it is necessary to generate data to carry on
simulations or to test programs when real data is not available.

it
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sequences

> 1:10
[11 12345 678910

> seq(10,50, 5)
[1] 10 15 20 25 30 35 40 45 50

> seq(10, by=5, length=10)
[1] 10 15 20 25 30 35 40 45 50 55

it
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the function g1 ()

generating levels

One common use of sequences is to generate factors for designed
experiments. Let's create the levels for an experiment with two groups,
three subgroups and two observations per subgroup:

> 1vl <- data.frame(group = gl(2, 6, length=12),
subgroup = gl(3, 2, length=12),
obs = gl(2, 1, length=12))

> 1vl

group subgroup obs
1 1 1 1
2 1 1 2
11 2 2 1
12 2 2
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the function expand.grid()

This function can be used to create a data frame with the unique
combinations of the elements of sequences.

> oe.grid <- expand.grid(odd = seq(l, 5, by=2),

even = seq(2, 5, by=2))

> oe.grid

odd even
1 1 2
2 3 2
3 5 2
4 1 4
5 3 4
6 b5 4

My
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the function expand.grid()

evaluating functions over a range of inputs

> xy <- expand.grid(x = 0:10, y = 0:10)
fcn <- function(row){row[1]"2 + row[2]"2}
> z <- apply(xy, 1, fcn)

v

> head(cbind(xy, z))

Xy z
100 0
210 1
320 4
430 9
540 16
6 50 25

e
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random numbers

Function  Distribution | | Function Distribution
rbeta Beta rlogis Logistic
rbimon Binomial rmultinom  Multinomial
rcauchy  Cauchy rnbinom Neg. Binomial
rchisq Chi-square rnorm Normal

rexp Exponential rpois Poisson

rf F rsignrank  Signed Rank
rgamma Gamma rt Student's t
rgeom Geometric runif Uniform
rhyper Hypergeometric rweibull Weibull
rlnorm Log Normal rwilcox Wilcoxon Rank Sum

Note: To be able to reproduce always the same results,

use the function set.seed()
ém‘ﬂ”wﬁ
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random numbers

Uniform random numbers

set.seed(123)

rn.1 <- runif (10, min=0, max=1)

rn.1

[1] 0.2875775 0.7883051 0.4089769 0.8830174 0.9404673
[6] 0.0455565 0.5281055 0.8924190 0.5514350 0.4566147

vV V V #

Normal random numbers

set.seed(123)

rn.2 <- rnorm(10, mean=0, sd=1)

> rn.2

[1] -0.56047565 -0.23017749 1.55870831 0.07050839
[6] 0.12928774 1.71506499 0.46091621 -1.26506123
[9] -0.68685285 -0.44566197

vV VvV #

ul ,
bl
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the sample () function

generating random permutations

# Random permutation from a vector
> x <- 1:10
> sample(x)
[11 9 7 610 4 8 3 2 1 5
> sample(10)
[11 4 3 2 9 7 8 110 6 5

# Sampling with replacement
> sample(10, replace=TRUE)
[1] 3915826328

# Sample size > input vector
> sample(5, size=10, replace=TRUE)
[11 52412253565
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the sample () function

generating random permutations

Histogram of rs

# Unequal probabilities g

> set.seed(111)

> pvec <- c(rep(0.5,2), rep(2,2), s B
rep(0,1),rep(1,5))/10 5

> rs <- sample(1:10, size=5000, ]

> hist(rs)

replace=TRUE, prob=pvec) . m

iy

R Programming II: Data Manipulation and Functions UCLA SCC

Denise Ferrari denise@stat.ucla.edu




Part VI

Writing Data
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writing R objects in ASCII format

The functions save() and save.image() usually save R objects into
binary files.

The ASCII format is convenient, since it produces human-readable files
that can be:

@ visually inspected using a simple text editor;

@ imported from other programs.

Two functions can be used to save objects in ASCII format files:
write() and write.table().

it
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the write () function

writing single-mode data

The write() function is useful to save data of the same mode.
It is the output equivalent of the scan() function.

> write(t(housing), file="housing.txt", ncolumns = ncol(housing))

Note: Matrices are stored internally in a columns-wise fashion. To write
a matrix in row-wise order, we need to use the transpose function t ()

and specify the number of desired columns.
ém‘ﬂ”wﬁ
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the write.table() function

writing mixed-mode data

The write.table() function is useful to save data of different modes,
such as data frames.

# Writing on the comnsole
> write.table(anneal,
quote=FALSE, row.names=FALSE, sep=",")

# Writing to a file
> write.table(anneal, file = "anneal.txt"
quote=FALSE, row.names=FALSE, sep=",")

it
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Part VII

Subscripting
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subscripting

Subscripting can be used to access and manipulate the elements of
objects like vectors, matrices, arrays, data frames and lists.

Subscripting operations are fast and efficient, and should be the preferred
method when dealing with data in R.

it
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numeric subscripts

In R, the first element of an object has subscript 1.

> x <- 1:10
> x
[11 1 2 3 4 5 6 7 8 910

> x[0]
integer(0)

> x[1]
[11 1

it
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numeric subscripts

A vector of subscripts can be used to access multiple elements of an
object.

> x <= 1:10
> x

[11 1 2 3 4 5 6 7 8 910

> x[c(1,3,5)]
[11 1 35

it
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numeric subscripts

Negative subscripts extract all elements of an object
except the one specified.

> x <= 1:10
> x

[11 1 2 3 4 5 6 7 8 910

> x[-c(1,3,5)]
[1] 2 4 6 7 8 9 10

How would you do to subscript some elements of a list?
Use the pets list created previously.

e
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character subscripts

If a subscriptable object has names associated to it, a character string or
vector of character strings can be used as subscripts.

> pets

$pet
[1] “dOg" "cat"
$number

> x <= 1:10 [1] 1 11

> names(x) <- letters[1:10] $male
1] 11

> x[c(llall’ Ilbll’ Ilcll)] [ ]

abc > pets[["pet"]]

123 [1] "dog" "cat"
> pets$pet
[1] ||d°gll llcatll

ul

oy
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logical subscripts

We can use logical values to choose which elements of the object to
access. Elements corresponding to TRUE in the logical vector are
included, and elements corresponding to FALSE are ignored.

> x <= 1:10; names(x) <- letters[1:10]
>x >5

a b c d e f g h i J
FALSE FALSE FALSE FALSE FALSE TRUE TRUE TRUE TRUE TRUE

> x[x > 5]
f g h i j

6 7 8 910

# using logical subscript to modify the object
> x[x > 5] <- 0

> x

abcdefghij
1234500000 éluj {
SAIIVA
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the which() function

This function can be useful when one wishes to find the indices of
elements that have a certain characteristic.

> y <- seq(1, 10, by=3)
>y
[1] 1 4 7 10

# even numbers
> which(y %% 2 == 0)
[11 2 4

# an equivalent expression
> seq(along=y) [y %% 2 == 0]
[1]1 2 4

oS
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subscripting multidimensional objects

matrices and arrays

For multidimensional objects, subscripts can be provided for each
dimension.

To select all elements of a given dimension, use the “empty” subscript.

> mat <- matrix(1:12, 3, 4, > mat[1, ]
byrow=TRUE) [11 1234

> mat

[,11 [,2] [,3] [,4] > mat[c(1,3),]
[1,] 1 2 3 4 [,11 [,2]1 [,3] [,4]
[2,1] 5 6 7 8 [1,] 1 4 7 10
[3,] 9 10 11 12 [2,] 3 6 9 12
> mat [5] How would you do to extract the
(11 6 even columns of the matrix?
> mat[2,2] Hint: use the which() function. M
[1] 6 o (| e
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the rev () function

reversing the order of rows and columns

> iris.rev <- iris[rev(l:nrow(iris)),]
> head(iris.rev)
Sepal.Length Sepal.Width Petal.Length Petal.Width  Species

150 5.9 3.0 5.1 1.8 virginica
149 6.2 3.4 5.4 2.3 virginica
148 6.5 3.0 5.2 2.0 virginica
147 6.3 2.5 5.0 1.9 virginica
146 6.7 3.0 5.2 2.3 virginica
145 6.7 3.3 5.7 2.5 virginica

Now, try to reverse the columns of the iris data frame.
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the order () function

sorting rows of a matrix arbitrarily

# sort the iris data frame by
# Sepal.Length
> iris.sort <- iris[order(iris[,"Sepal.Length"]),]
> head(iris.sort)
Sepal.Length Sepal.Width Petal.Length Petal.Width Species

14 4.3 3.0 1.1 0.1 setosa
9 4.4 2.9 1.4 0.2 setosa
39 4.4 3.0 1.3 0.2 setosa
43 4.4 3.2 1.3 0.2 setosa
42 4.5 2.3 1.3 0.3 setosa
4 4.6 3.1 1.5 0.2 setosa

Try to sort the iris data frame in decreasing order with respect to Sepal.Width.
Hint: use the decreasing=TRUE argument.

b
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the drop= argument

avoiding dimension reduction

By default, subscripting operations reduce the dimensions of an array
whenever possible. To avoid that, we can use the drop=FALSE argument.

> s1 <- mat[1,]; si
[11 1234

> dim(s1)

NULL

> s2 <- mat[1,,drop=FALSE]; s2
[,11 [,21 [,31 [,4]

[1,] 1 2 3 4

> dim(s2)

[1] 1 4
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éw‘uw A

UCLA sCC

Denise Ferrari denise@stat.ucla.edu

R Programming II: Data Manipulation and Functions




combined selections for matrices

Suppose we want to get all the columns for which the element at the first
row is less than 3:

> mycols <- mat[1,] < 3; mycols
[1] TRUE TRUE FALSE FALSE

> mat[ , mycols, drop=FALSE]
[,11 [,2]
[1,] 1 2

it
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complex logical expressions

subscripting data frames

> dat <- data.frame(a = seq(5, 20, by=3),
b = c(8, NA, 12, 15, NA, 21))
> dat[dat$b < 10, ]

a b
1 5 8
NA NA NA
NA.1 NA NA

# removing the missing values

> dat[!is.na(dat$b) & dat$b < 10, ]
a b

1 5 8

e
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the function subset ()

subscripting data frames

The function subset () allows one to perform selections of the elements
in a data frame in very simple way.

> dat <- data.frame(a = seq(5, 20, by=3),
b = c(8, NA, 12, 15, NA, 21))

> subset(dat, b < 10)
ab
158

Note: The subset () function always returns a new data frame, matrix
of vector, and is not adequate for modifying elements of a data frame. “L l! l
é‘ A
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Part VIII

Loops and Functions

bt
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loops

A loop allows the program to repeatedly execute commands. Loops are
common to many programming languages and their use may facilitate
the implementation of many operations.

There are three kinds of loops in R:
@ ‘for’ loops
@ ‘while’ loops

@ ‘repeat’ loops

Note: Loops can be very inefficient in R.
For that reason, their use is not advised, unless necessary.

it
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‘“for’ loops
General form:

for (variable in sequence) {
set_of_expressions

}

> for(i in 1:10) {
print(sqrt(i))
}

[1]1 1

[1] 1.414214
[1] 1.732051

iij 3.162278
2“&@%&
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‘while’ loops

General form:

while (condition) {
set_of_expressions

}

>a<-0; b<-1

> while(b < 10) { Eﬂ 1
print (b) [1] 2
temp <- atb [1] 3
‘: :: :emp eI
) [1]1 8

My
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‘repeat’ loops
General form:

repeat (condition) {
set_of_expressions
if (condition) { break }
¥

>a<-0;b<1

> repeat { [1]1 1
print (b) (11 1
temp <- at+b [1] 2
a<-b [1] 3
b <- temp [11 5
if (b>=10) {break} [11 8

d ul

A
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Note: The loop is terminated by the break command.
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cleaning the mess

In the previous cases, the output and the R commands are both shown in
the console.

To have a cleaner version when working with loops, we can do:

# Arithmetic Progression

>x <= 1; d <= 2

> while (length(x) < 10) {
position <- length(x)
new <- x[position]+d
x <- c(x,new)

}

> print(x)
[11] 1 3 5 7 9 11 13 15 17 19
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writing functions

A function is a collection of commands that perform a specific task.

General form:

function.name <- function (arguments){
set_of_expressions
return (answer)

}

it
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writing functions

Example: Arithmetic Progression

> AP <- function(a, d, n){

x <- a

while (length(x) < n){
position <- length(x)
new <- x[position]+d
x <- c(x, new)

}

return(x)

}

it
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writing functions

Once you run this code, you will have available a new function called AP.
To run the function, type on the console:

> AP(1,2,10)
[1] 1 3 5 7 9 11 13 15 17 19

> AP(1,0,10)
[1J] 1111111111

Note that for d==0 the function is returning a sequence of ones.
We can easily fix this with an if statement.

it
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the ‘if’ statement

General form:

if (condition) {
set_of_expressions

}
We can also combine the ‘if’ with the ‘else’ statement:

if (condition) {
set_of_expressions

} else {
set_of_expressions

3

it
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the ‘if’ statement

> AP <- function(a, d, n){
if(d ==0) {
return("Error: argument ‘d’ should not be 0")
break
} else {
x <- a
while (length(x) < n){
position <- length(x)
new <- x[position]+d
x <- c(x, new)
}
return(x)
}
¥

> AP(1, 0, 3)

[1] "Error: argument ‘d’ should not be 0" lu} ‘
é- u!IUJﬂ
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the ‘ifelse’ statement
The ‘if’ statement works fine if you are conditioning on a single value.

If you are working with a vector, the ‘ifelse’ statement can come in
handy.

General form:

ifelse (test, yes, no)

> x <= c(6:-4)
> sqrt(x) # gives a warning

# fix that with an ifelse statement
> sqrt(ifelse(x >= 0, x, NA))

R Programming II: Data Manipulation and Functions UCLA SCC
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exercise

A geometric progression is defined by the recursive relation
an=1"r-ap-1

Try to create a function GP that gives the geometric progression.

Do not forget to use:

- ‘if’ statements

- warning messages

it
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Part IX

Beyond the Command Line
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beyond the command line

As mentioned earlier, the process of
using R requires the user to type
commands on the console window

800 e, 00O

TUsers Shared deniseterart @ )

and click return.

This can be burdensome, specially if
you need to repeat a certain
collection of commands from time to
time, or if you wish to fix mistakes.

So, instead of typing your

R version 2.9.1 (2009-06-26)
Copyright (C) 2009 The R Foundation for Statistical Computing
ISBN 3-000051-07-0

R is free softeare and comes with ABSOLUTELY NO WARRANTY.

You are welcome to redistribute it under certain conditions.

Type 'license)' or 'licence()' for distribution details.
Natural language support but running in an English locale

R is a collaborative project with many contributors.

Type 'contributors()' for more information and

“citation()’ on how to cite R or R packages in publications.

Type 'demo()’ for some demos, "help()' for on-line help, or

*help.start()" for an HTML browser interface to help.

Type 'a0)’ to quit R.

[R.app GUI 1.28 (5444) i386-apple-darwing.11.1]

)

commands on the console window,

you can use an R script. An R script

is just a text file where you can write R startup window:

and save R commands for later use. aka console or command window. él‘LM

O
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the text editor

Using a special text editor to type, document and save code for later use
is highly recommended.

There is a great variety of external text editors available.
We are going to use the R built-in editor.

it
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script code

ace _Packages & Data_Misc_Window _Help

To create a new R script , you may:

@ choose File > New Document,
or 5

@ hit Command + N

So, now, you're ready to start
creating R code.

st 1.28 et

il
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script code

To open an existing R script , you

may:

@ choose File > Open Document,

or

@ from Finder, double-click the

desired R script file.

Denise Ferrari denis:

R Programming |

stat.ucla.edu

Data Manipulation and Functions

Q- Help search

## FUNCTION: LHS

2

3

4 ## Author: Denise B. Ferrari
s ## Date Created: Jul 27 2009
& ## Date Modified: Sep 18 2009

## PURPOSE:
s ## Creat a Latin Hypercube Design

11 ## PARAMETERS:

12 ## name description
u ##n number of runs

1 # s number of dimensions

15 ## ab c(al,bl,a2,b2,. .. ,as,bs)
15 #

17 ## NOTE:

15 ## The experimental domain is considered to be:
15 ## [a1,b1]x[a2xb2]x. . .x[as,bs]

i
21 #4 RETURN:
2z # Dn: Sampled points generated by the LHS
it

25 LHS <= function(n,s, ab){

T

NN

ikt




script code

If you're not interested in editing the script, you can just run it.
To run a script, let's say one with the name:
/Users/deniseferrari/Documents/Rcode/LHS.R

you may use:

@ The R command line:
source("/Users/deniseferrari/Documents/Rcode/LHS.R")

@ Terminal:
R CMD BATCH /Users/deniseferrari/Documents/Rcode/LHS.R

it
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documenting script code

general guidelines

80 [ Hs

2| #4 FUNCTION: LS

2 8 Ruthor: Dentse 5. Ferrar
3 74 e Creatass” it 27 3000
o ## Date Modified: Sep 18 2009

It is important that you write code in a i oo

o ## Creat o Latin Hypercube Design

clear, simple and well documented way. e s
The following is a list with some Rl e

m\J

general guidelines: e o pertmertat donatn 15 considared to e

i 42 Lot bUINCsZA620x. . xLon, 8]

o e e

@ Add comments: start the line with 3 t’ Dot Sacpled potnts generated by the LS
the symbol “#"

27 # create matrix with interval limits
25 AB <- matrix(ab, ncol=2, byrow=TRUE)

@ Use indentations to indicate which e

Bt < <O

pieces of code belong together. [ .

5 pij < mabrix(tl, ncol-s)

@ Add spaces around commands, 3|+ step 2: cenrate ns untror vartate Cranon inbers>

s set.seed(40206)

H 39 rn <- matrix(runif(n*s, @, 1), ncol=s)
variables, commas, etc. b
& u1 < ma(nx(rep(((AB[ 2] AB[ 1]) n) ncol=s, byrow=TRUE)
“ u2 <- matrix(rep(AB[,1],n), ncol=s, byrow=TRUE)
o Dn <- ul*xn + u2 # ~ unif(ai,bi)_{i=1,...,s} "r,
p ML
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using

scripts to change directories

**

VvV #*

v

VvV #*

VvV #

store the current directory
old.dir <- getwd()

move to the new directory
setwd("/Users/deniseferrari/Documents/Rcode")

set the output file
sink("2009-09-20.o0ut")

perform all desired tasks

close the output file
sink()

go back to the original directory

setwd(old.dir) “L l! ll
é. G20
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more general advice

Common errors can be avoided if extra care is taken regarding the
following aspects:
@ R is case sensitive
So, a variable called my.var is NOT the same as a variable called
My.var or my.Var, etc.

@ Brackets: { },[] ()
Programming makes intense use of brackets. Make sure that an
opening bracket { is matched with a closing bracket } and that it is
used in the correct position for the task.

it
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Part X

Additional Resources
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e Alain F. Zuur et. al. (2009).

A Beginner's Guide to R. Use R! Series. Springer.
@ Phil Spector (2008).

Data Manipulation with R. Use R! Series. Springer.
@ Owen Jones et. al. (2009).

Introduction to Scientific Programming and Simulation Using R.
Chapman & Hall.
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online resources

CRAN: http://cran.stat.ucla.edu/
R search engine: http://www.rseek.org
Quick R: http://www.statmethods.net/index.html

UCLA Statistics Information Portal:
http://info.stat.ucla.edu/grad

UCLA Statistical Consulting Center
E-consulting and Walk-in Consulting http://scc.stat.ucla.edu

it
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http://info.stat.ucla.edu/grad
http://scc.stat.ucla.edu

upcoming mini-courses

Monday April 12 LaTeX I: Writing a Document, Paper or Thesis
Wednesday April 14 LaTeX II: Bibliographies, Style and Math

For a schedule of all mini-courses offered please visit
http://scc.stat.ucla.edu/mini-courses.

it
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